Chapter 4
Feature Design Tree

Learning Objectives

♦ Understand Feature Interactions
♦ Use the FeatureManager Design Tree
♦ Modify and Update Feature Dimensions
♦ Perform History-Based Part Modifications
♦ Change the Names of Created Features
♦ Implement Basic Design Changes
Certified SolidWorks Associate Exam Objectives Coverage

Sketch Entities – Lines, Rectangles, Circles, Arcs, Ellipses, Centerlines
Objectives: Creating Sketch Entities.
   Edit Sketch .........................................................4-23
   Sketch Fillet ......................................................4-24

Boss and Cut Features – Extrudes, Revolves, Sweeps, Lofts
Objectives: Creating Basic Swept Features.
   Edit Feature.........................................................4-22
   Rename Feature ..................................................4-17

Dimensions
Objectives: Applying and Editing Smart Dimensions.
   Show Feature Dimensions .................................4-8

Feature Conditions – Start and End
Objectives: Controlling Feature Start and End Conditions.
   Extruded Boss/Base, Mid-Plane .........................4-13
   Extruded Boss/Base, Up to Surface .................4-16
Introduction

In SolidWorks, the design intents are embedded into features in the FeatureManager Design Tree. The structure of the design tree resembles that of a CSG binary tree. A CSG binary tree contains only Boolean relations, while the SolidWorks design tree contains all features, including Boolean relations. A design tree is a sequential record of the features used to create the part. This design tree contains the construction steps, plus the rules defining the design intent of each construction operation. In a design tree, each time a new modeling event is created previously defined features can be used to define information such as size, location, and orientation. It is therefore important to think about your modeling strategy before you start creating anything. It is important, but also difficult, to plan ahead for all possible design changes that might occur. This approach in modeling is a major difference of FEATURE-BASED CAD SOFTWARE, such as SolidWorks, from previous generation CAD systems.

Feature-based parametric modeling is a cumulative process. Every time a new feature is added, a new result is created and the feature is also added to the design tree. The database also includes parameters of features that were used to define them. All of this happens automatically as features are created and manipulated. At this point, it is important to understand that all of this information is retained, and modifications are done based on the same input information.

In SolidWorks, the design tree gives information about modeling order and other information about the feature. Part modifications can be accomplished by accessing the features in the design tree. It is therefore important to understand and utilize the feature design tree to modify designs. SolidWorks remembers the history of a part, including all the rules that were used to create it, so that changes can be made to any operation that was performed to create the part. In SolidWorks, to modify a feature, we access the feature by selecting the feature in the FeatureManager Design Tree window.
Starting SolidWorks

1. Select the SolidWorks option on the Start menu or select the SolidWorks icon on the desktop to start SolidWorks. The SolidWorks main window will appear on the screen.

2. Select the New icon with a single click of the left-mouse-button on the Menu Bar.

3. The New SolidWorks Document dialog appears in Novice mode. Click once with the left-mouse-button on the Advanced button to switch to Advanced mode.

- In Advanced mode, the New SolidWorks Document dialog box offers the same three options as in Novice mode. These options allow starting a new document using the default templates for a Part, Assembly, or Drawing. However, the Advanced mode will allow us to start new documents with user-defined templates.

4. Select the Part icon with a single click of the left-mouse-button in the New SolidWorks Document dialog box.

Creating a User-Defined Part Template

- We will create a part template which includes setting for the use of ANSI standards for dimensions and English (inch, pound, second) units. In the future, using this template will eliminate the need to adjust these document settings each time a new part is started.

1. Select the **Options** icon from the **Menu Bar** to open the **Options** dialog box.

2. Select the **Document Properties** tab.

3. Select **ANSI** in the pull-down selection window under the **Overall drafting standard** panel as shown.

4. Click **Units** as shown below.

5. Select **IPS (inch, pound, second)** under the **Unit system** options.

6. Select **.123** in the **Decimals** spin box for the **Length units** as shown to define the degree of accuracy with which the units will be displayed to 3 decimal places.
7. Click **OK** in the *Options* dialog box to accept the selected settings.

8. Click the arrow next to the **Save** icon in the *Menu Bar* to reveal the save options and select **Save As**.

9. We will create a new folder for the user-defined templates. Decide where you want to locate this new folder and use the browser in the *Save As* dialog box to select the location. (Note: In the figure below, the C: folder is chosen.)

10. In the *Save As* dialog box, select the **New Folder** option by clicking once with the left-mouse-button on the icon as shown.

11. The new folder appears with the default name **New Folder**. Type the file name **Tutorial_Templates** for the new folder. (Note: This folder could also be created using Windows Explorer, etc.)
12. Under *Save as type*, select **Part Templates (*.prtdot)**. Notice the browser automatically goes to the default *Templates* folder.

13. Use the *Save in* browser to select the **Tutorial_Templates** folder you created.

14. Enter the file name **Part_IPS_ANSI**.

15. Click **Save** to save the new part template file.

16. Select **Close** in the *File* pull-down menu to close the document. (NOTE: You may have to move the mouse over the **SolidWorks** icon to reveal the pull-down menus.)

We will now open a new part document using the template we just saved.

17. Select the **New** icon with a single click of the left-mouse-button on the *Menu Bar*. The *New SolidWorks Document* dialog box appears in Advanced mode.

18. Notice that the new template does not appear as an option. Click **Cancel** in the *New SolidWorks Document* dialog box.
19. Select the **Options** icon from the **Menu Bar** to open the **Options** dialog box.

20. Select **File Locations** under the **System Options** tab as shown.

21. Make sure **Document Templates** is selected as the **Show folders for:** option.

22. Click the **Add** button to add the directory with the user-defined templates to the list of folders containing document templates.

23. Locate and select the **Tutorial_Templates** folder using the browser, and click **OK** in the **Browse For Folder** dialog box.

24. Select **OK** in the **Options** dialog box.

25. If a pop-up window with the question "**Would you like to make the following changes to your search paths?**" appears, click **Yes**.
26. Select the **New** icon with a single click of the left-mouse-button on the **Menu Bar**. Notice the **Tutorial_Templates** folder now appears as a tab in the **New SolidWorks Document** dialog box.

27. Select the **Tutorial_Templates** tab.

28. Notice the **Part_IPS_ANSI** template appears. Select the **Part_IPS_ANSI** template as shown.

29. Click on the **OK** button to open a new document.

**The Saddle Bracket Design**

- Based on your knowledge of **SolidWorks** so far, how many features would you use to create the design? Which feature would you choose as the **BASE FEATURE**, the first solid feature, of the model? What is your choice in arranging the order of the features? Would you organize the features differently if additional fillets were to be added in the design? Take a few minutes to consider these questions and do preliminary planning by sketching on a piece of paper. You are also encouraged to create the model on your own prior to following through the tutorial.
Modeling Strategy
The **SolidWorks FeatureManager Design Tree**

- In the *SolidWorks* screen layout, the **FeatureManager Design Tree** is located to the left of the graphics window. *SolidWorks* can be used for part modeling, assembly modeling, part drawings, and assembly presentation. The **FeatureManager Design Tree** window provides a visual structure of the features, relations, and attributes that are used to create the part, assembly, or scene. The **FeatureManager Design Tree** also provides right-click menu access for tasks associated specifically with the part or feature, and it is the primary focus for executing many of the *SolidWorks* commands.

- The first item displayed in the **FeatureManager Design Tree** is the name of the part, which is also the file name. By default, the name “Part1” is used when we first started *SolidWorks*. The **FeatureManager Design Tree** can also be used to modify parts and assemblies by moving, deleting, or renaming items within the hierarchy. Any changes made in the **FeatureManager Design Tree** directly affect the part or assembly and the results of the modifications are displayed on screen instantly. The **FeatureManager Design Tree** also reports any problems and conflicts during the modification and updating procedure.

**Creating the Base Feature**

1. Move the graphics cursor to the **Front Plane** icon in the **FeatureManager Design Tree**. Notice the **Front Plane** icon is highlighted in the design tree and the **Front Plane** outline appears in the graphics area. Click once with the **left-mouse-button** to select the Front Plane.

2. In the **Sketch** toolbar, select the **Sketch** command by left-clicking once on the icon. Notice the Front Plane automatically becomes the sketch plane because it was pre-selected.
3. Select the **Line** icon on the **Sketch** toolbar by clicking once with the **left-mouse-button**; this will activate the **Line** command.

4. On your own, create and adjust the geometry by adding and modifying dimensions as shown below.

5. Click once with the **left-mouse-button** on the **Sketch** icon on the **Sketch** toolbar to exit the **Sketch** option.

6. Select the **View Orientation** button on the **Heads-up View** toolbar by clicking once with the **left-mouse-button**.

7. Select the **Isometric** icon in the **View Orientation** pull-down menu.
8. Make sure the sketch – Sketch1 – is selected in the FeatureManager Design Tree.

9. In the Features toolbar, select the **Extruded Boss/Base** command by clicking once with the left-mouse-button on the icon.

10. In the Extrude PropertyManager panel, click the drop down arrow to reveal the options for the **End Condition** (the default end condition is Blind) and select **Mid Plane** as shown.

11. In the Extrude PropertyManager panel, enter **2.5** as the extrusion distance. Notice that the sketch region is automatically selected as the extrusion profile.

12. Click on the **OK** button to accept the settings and create the base feature.

   ➢ On your own, use the **Viewing** functions to view the 3D model. Also notice the extrusion feature is added to the **Model Tree** in the FeatureManager Design Tree area.
Adding the Second Solid Feature

1. In the Menu Bar, select the Sketch command by left-clicking once on the icon.

2. Notice the left panel displays the Edit Sketch PropertyManager with the instruction "Select a plane on which to create a sketch for the entity." Move the graphics cursor on the 3D part and notice that SolidWorks will automatically highlight feasible planes and surfaces as the cursor is on top of the different surfaces. Move the cursor inside the upper horizontal face of the 3D object as shown below.

3. Click once with the right-mouse-button to bring up the option menu and select Select Other to switch to the next feasible choice.

4. The Select Other pop-up dialog box appears. On your own, move the cursor over the options (e.g., Face) in the box to examine all possible surface selections.

5. Click on the Face selection in the Select Other dialog box to select the bottom horizontal face of the solid model when it is highlighted as shown in the figure.

Accept the bottom surface to align the sketching plane.
Creating a 2D Sketch

1. Select the **Circle** command by clicking once with the left-mouse-button on the icon in the Sketch toolbar.

   > We will align the center of the circle to the midpoint of the base feature.

2. Move the cursor along the shorter edge of the base feature and pick the midpoint of the edge when the midpoint is displayed with a RED color as shown in the figure.

3. Select the front corner of the base feature to create a circle as shown below.

4. Inside the graphics window, click once with the right-mouse-button to display the option menu. Select **Select** in the popup menu to end the Circle option.
5. Click once with the **left-mouse-button** on the **Sketch** icon on the **Sketch** toolbar to exit the **Sketch** option.

6. Make sure the sketch – **Sketch2** – is selected in the **FeatureManager Design Tree**.

7. In the **Features** toolbar, select the **Extruded Boss/Base** command by clicking once with the left-mouse-button on the icon.

8. Click the **Reverse Direction** button in the **PropertyManager** as shown. The extrude preview should appear as shown below.

9. In the **Extrude PropertyManager** panel, click the drop down arrow to reveal the pull options for the **End Condition** (the default end condition is **Blind**) and select **Up To Surface**.

10. Select the top face of the base feature as the termination surface for the extrusion. Notice **Face<1>** appears in the surface selection window in the **Extrude PropertyManager**.

11. Confirm the **Merge result** checkbox is checked.

12. Click on the **OK** button to proceed with the **Join** operation.
Renaming the Part Features

Currently, our model contains two extruded features. The feature is highlighted in the display area when we select the feature in the FeatureManager Design Tree window. Each time a new feature is created, the feature is also displayed in the Design Tree window. By default, SolidWorks will use generic names for part features. However, when we begin to deal with parts with a large number of features, it will be much easier to identify the features using more meaningful names. Two methods can be used to rename the features: 1. clicking twice on the name of the feature; and 2. using the Properties option. In this example, the use of the first method is illustrated.

1. Select the first extruded feature in the Model Browser area by left-clicking once on the name of the feature, Extrude1. Notice the selected feature is highlighted in the graphics window.

2. Left-mouse-click on the feature name again to enter the Edit mode as shown.

3. Enter Base as the new name for the first extruded feature.

4. On your own, rename the second extruded feature to Circular_End.
Adjusting the Width of the Base Feature

One of the main advantages of parametric modeling is the ease of performing part modifications at any time in the design process. Part modifications can be done through accessing the features in the design tree. SolidWorks remembers the history of a part, including all the rules that were used to create it, so that changes can be made to any operation that was performed to create the part. For our Saddle Bracket design, we will reduce the size of the base feature from 3.25 inches to 3.0 inches, and the extrusion distance to 2.0 inches.

1. Inside the FeatureManager Design Tree area, right-mouse-click on Annotations to bring up the option menu and select the Show Feature Dimensions option in the pop-up menu. This option will allow us to view and edit dimensions by moving the cursor over the corresponding feature on the model.

2. Move the cursor over the model to reveal the dimension indicating the 3.25 overall width of the Base feature.

3. Select the overall width of the Base feature, the 3.25 dimension value, by double-clicking on the dimension text, as shown.

4. Enter 3.0 in the Modify window and click the OK button.

5. On your own, repeat the above steps and modify the extruded distance from 2.5 to 2.0.

6. Click Rebuild in the Menu Bar.

Note that SolidWorks updates the model by re-linking all elements used to create the model. Any problems or conflicts that occur will also be displayed during the updating process.

7. Right-mouse-click on Annotations to bring up the option menu and de-select the Show Feature Dimensions option in the pop-up menu.
Adding a Hole

1. In the *Features* toolbar, select the **Hole Wizard** command by clicking once with the left-mouse-button on the icon as shown.

2. In the *Hole Specification PropertyManager*, select the **Positions** panel by clicking once with the left-mouse-button on the **Positions** tab as shown. The **Positions** tab allows you to locate the hole on a planar or non-planar face.

3. Move the cursor over the circular edge of the top face as shown. (Do not click.) Notice the center mark appears.

4. Select the **Center** point by left-clicking once on the icon as shown.
5. In *Hole PropertyManager*, select the **Type** panel by clicking once with the left-mouse-button on the **Type** tab as shown.

5. Select the **Type** tab.

6. Select the **Hole** icon under *Hole Specification* option. (This is the default setting and probably already selected.)

6. Select **Hole** button.

7. Select **Ansi Inch** in the *Standard* option window.

7. Select **Ansi Inch**.

8. Set the **Size** option to a diameter of **3/4** in.

8. Set to **3/4 in.**

9. Set the *End Condition* option to **Through All**.

9. Select **Through All**.

10. Click the **OK** button (green check mark) in the *Hole PropertyManager* to proceed with the hole feature.
Creating a Rectangular Extruded Cut Feature

1. Move the cursor into the graphics area, away from the model, and click once with the left-mouse-button to ensure that no features are selected.

2. Select the **Sketch** button on the **Sketch** toolbar to create a new sketch.

3. Pick the **vertical face** of the solid as shown. (Note the alignment of the origin of the sketch plane.)

- On your own, create a rectangular \((1.0 \times 0.75)\) **Extruded Cut** feature (use the **Up To Next** option for the **End Condition**) as shown and rename the feature to **Rect_Cut**.
History-Based Part Modifications

- *SolidWorks* uses the *history-based part modification* approach, which enables us to make modifications to the appropriate features and re-link the rest of the history tree without having to reconstruct the model from scratch. We can think of it as going back in time and modifying some aspects of the modeling steps used to create the part. We can modify any feature that we have created. As an example, we will adjust the depth of the rectangular cutout.

1. In the *FeatureManager Design Tree* window, select the last cut feature, *Rect_Cut*, by left-clicking once on the name of the feature.

2. In the *FeatureManager Design Tree* window, right-mouse-click once on the *Rect_Cut* feature.

3. Select the *Edit Feature* button in the pop-up menu. Notice the *Extrude PropertyManager* appears on the screen.

4. In the *Extrude PropertyManager*, set the termination *End Condition* to the *Through All* option.

5. Click on the *OK* button to accept the settings.

- As can been seen, the history-based modification approach is very straightforward and it only took a few seconds to adjust the cut feature to the *Through All* option.
A Design Change

- Engineering designs usually go through many revisions and changes. SolidWorks provides an assortment of tools to handle design changes quickly and effectively. We will demonstrate some of the tools available by changing the Base feature of the design.

1. In the FeatureManager Design Tree window, select the Base feature by left-clicking once on the name of the feature.

2. Pick the Edit Sketch button in the pop-up menu.

- SolidWorks will now display the original 2D sketch of the selected feature in the graphics window. We have literally gone back in time to the point where we first created the 2D sketch. Notice the feature being modified is also highlighted in the desktop FeatureManager Design Tree.

3. Click on the Normal To icon in the View Orientation pull-down menu on the Heads-up View toolbar.

- The Normal To command automatically aligns the sketch plane of a selected entity to the screen. We have literally gone back in time to the point where we first created the 2D sketch.
4. Select the **Sketch Fillet** command in the **Sketch** toolbar.

5. In the **Sketch Fillet PropertyManager**, enter **0.25** as the new radius of the fillet. (Note: If the **Fillet Parameters** panel is minimized, click on the double arrows to expand the panel.)

6. Select the two edges as shown to create the fillet.

- Note that the fillet is created automatically with the dimension attached. The attached dimension can also be modified through the history tree.

7. Click the **OK** icon (green check mark) in the **PropertyManager**, or hit the **[Esc]** key once, to end the **Sketch Fillet** command.

8. Click on the **Rebuild** icon in the **Menu Bar**.

9. Save the part with the file name **Saddle Bracket**.
In a typical design process, the initial design will undergo many analyses, testing, and reviews. The history-based part modification approach is an extremely powerful tool that enables us to quickly update the design. At the same time, it is quite clear that PLANNING AHEAD is also important in doing feature-based modeling.
Questions:

1. What are stored in the SolidWorks FeatureManager Design Tree?

2. When extruding, what is the difference between Blind and Through All?

3. Describe the history-based part modification approach.

4. What determines how a model reacts when other features in the model change?

5. Describe the steps to rename existing features.

6. Describe two methods available in SolidWorks to modify the dimension values of parametric sketches.

7. Create Design Tree sketches showing the steps you plan to use to create the two models shown on the next page:

Ex.1)

Ex.2)
Exercises: (Dimensions are in inches.)

1. Plate thickness: 0.25 inches.

2. Base plate thickness: 0.25 inches. Boss height 0.5 inches.
3.